
What’s New



Autodesk 
®
 Maya

®
 2012

©2011Autodesk, Inc. All rights reserved. Except as otherwise permitted by Autodesk, Inc., this publication, or parts thereof, may not
be reproduced in any form, by any method, for any purpose.
Certain materials included in this publication are reprinted with the permission of the copyright holder.
The following are registered trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and other countries:
3DEC (design/logo), 3December, 3December.com, 3ds Max, Algor, Alias, Alias (swirl design/logo), AliasStudio, Alias|Wavefront (design/logo),
ATC, AUGI, AutoCAD, AutoCAD Learning Assistance, AutoCAD LT, AutoCAD Simulator, AutoCAD SQL Extension, AutoCAD SQL Interface,
Autodesk, Autodesk Intent, Autodesk Inventor, Autodesk MapGuide, Autodesk Streamline, AutoLISP, AutoSnap, AutoSketch, AutoTrack, Backburner,
Backdraft, Beast, Built with ObjectARX (logo), Burn, Buzzsaw, CAiCE, Civil 3D, Cleaner, Cleaner Central, ClearScale, Colour Warper, Combustion,
Communication Specification, Constructware, Content Explorer, Dancing Baby (image), DesignCenter, Design Doctor, Designer's Toolkit,
DesignKids, DesignProf, DesignServer, DesignStudio, Design Web Format, Discreet, DWF, DWG, DWG (logo), DWG Extreme, DWG TrueConvert,
DWG TrueView, DXF, Ecotect, Exposure, Extending the Design Team, Face Robot, FBX, Fempro, Fire, Flame, Flare, Flint, FMDesktop, Freewheel,
GDX Driver, Green Building Studio, Heads-up Design, Heidi, HumanIK, IDEA Server, i-drop, Illuminate Labs AB (design/logo), ImageModeler,
iMOUT, Incinerator, Inferno, Inventor, Inventor LT, Kynapse, Kynogon, LandXplorer, LiquidLight, LiquidLight (design/logo), Lustre, MatchMover,
Maya, Mechanical Desktop, Moldflow, Moldflow Plastics Advisers, MPI, Moldflow Plastics Insight, Moldflow Plastics Xpert, Moondust, MotionBuilder,
Movimento, MPA, MPA (design/logo), MPX, MPX (design/logo), Mudbox, Multi-Master Editing, Navisworks, ObjectARX, ObjectDBX, Opticore,
Pipeplus, PolarSnap, PortfolioWall, Powered with Autodesk Technology, Productstream, ProMaterials, RasterDWG, RealDWG, Real-time Roto,
Recognize, Render Queue, Retimer, Reveal, Revit, RiverCAD, Robot, Showcase, Show Me, ShowMotion, SketchBook, Smoke, Softimage,
Softimage|XSI (design/logo), Sparks, SteeringWheels, Stitcher, Stone, StormNET, StudioTools, ToolClip, Topobase, Toxik, TrustedDWG, U-Vis,
ViewCube, Visual, Visual LISP, Volo, Vtour, WaterNetworks, Wire, Wiretap, WiretapCentral, XSI.
ACE™, TAO™, CIAO™, and CoSMIC™ are copyrighted by Douglas C. Schmidt and his research group at Washington University, University of
California, Irvine, and Vanderbilt University, Copyright (c) 1993-2009, all rights reserved.
mental ray is a registered trademark of mental images GmbH licensed for use by Autodesk, Inc.
Intel is a registered trademark or trademark of Intel Corporation or its subsidiaries in the United States and other countries.
OpenGL is a trademark of Silicon Graphics, Inc. in the United States and other countries.
Python is a registered trademark of Python Software Foundation.
All other brand names, product names or trademarks belong to their respective holders.

Disclaimer
THIS PUBLICATION AND THE INFORMATION CONTAINED HEREIN IS MADE AVAILABLE BY AUTODESK, INC. “AS IS.” AUTODESK, INC. DISCLAIMS
ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE REGARDING THESE MATERIALS.



Contents

Chapter 1 What's New .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1
What's New .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1

What's New in Autodesk Maya .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1
What's New in General .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 6
What's New in Performance .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 6
What's New in Basics .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 7
What's New in Assets and File Referencing  .  .  .  .  .  .  .  .  .  .  .  .  . 9
What's New in Modeling .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 10
What's New in Animation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 12
What's New in Rigging .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 16
What's New in Dynamics and nDynamics .  .  .  .  .  .  .  .  .  .  .  .  . 19

General .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 19
Fluid Effects .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 21
nCloth .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 26
nParticles .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 28

What's New in Rendering and Render Setup .  .  .  .  .  .  .  .  .  .  .  . 28
What's New in API .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 31
What's New in MEL and Python .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 31
What's New in Documentation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 32
What's New - Previous versions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 33

iii



iv



What's New

What's New

What's New in Autodesk Maya

Welcome to What’s New in Autodesk® Maya® 2012.

Maya 2012 delivers new toolsets for previsualization and game prototyping,
extends the simulation feature set, and opens the way for better pipeline
integration.

With a high-performance viewport; the ability to create node-based
representations of render passes; an expanded camera sequencer toolset; and
new camera rigs, artists can refine and present their ideas prior to final
production. And, editable motion trails offer an enhanced animation experience.

In addition, enhancements of the Nucleus solver and its modules, combined
with new physics solvers, help you create a wider range of convincing effects
in less time.

Similarly, single-step interoperability between Autodesk products, a consistent
f-curve editor across products, and new support for vector displacement maps
make Maya 2012 easier to integrate into production pipelines.

Watch the Maya 2012 Feature Highlights video, and read the sections below
for more information about all the new features in this release.

General and Performance

New to Maya 2012 are several single-step workflows to make sending scene data
between Autodesk 3D applications seamless. In addition, several performance
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improvements have been made this release in the Dynamics and nDynamics
areas, and Viewport 2.0.
■ What's New in General (page 6)

■ What's New in Performance (page 6)

Basics

A newly designed Project Window provides greater
flexibility for accessing and editing the location of your
project files. An improved default project structure
makes it easier to manage project directories as well as
to create custom directories for plug-in data.

See What's New in Basics (page 7).

Assets and File Referencing

A new Namespace Editor design gives you more
control creating and managing the namespace organ-
ization of your scene objects. Feature improvements
include object lists in a pop-up window, better
namespace hierarchy display, and more.

See What's New in Assets and File Referencing (page
9).
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Modeling

The new Send to feature provides an easy, single-step
method of sending objects and various forms of data
from Maya to Mudbox.

The new Interactive Split tool is one of several new
options available through the Edit Mesh menu. It al-
lows you to accurately split faces on a polygon mesh.
Additionally, the new Project Curve on Mesh option
lets you project curves on a polygon surface, while the
new Split Mesh with Projected Curve option lets
you split and detach edges on a polygon surface.

There are also three new sliders associated with the
Show Manipulator Tool.

See What's New in Modeling (page 10).

Animation

Editable Motion Trails provide animators with a fast
workflow for editing the position and timing of keys,
directly in the Maya scene. Motion trails display with
your animated models, eliminating the need to leave
your scene for the Graph Editor.

Updates to the Camera Sequencer include a new
playlist for more efficient shot management, improved
multi-track audio, and the addition of the Ubercam,
which lets you quickly output all shots to a single
camera.

In addition, several improvements to the Graph Ed-
itor provide a more streamlined and familiar curve
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editing tool, particularly for animators using multiple
Autodesk applications in a pipeline. New options and
preferences include the Auto tangent type, adjacent
key snapping, single-click curve editing, plus the Re-
gion Tool for scaling multiple keys.

See What's New in Animation (page 12).

Rigging

New HumanIK character setup tools in Maya improve
both keyframing and retargeting workflows, with a
focus on visual, intuitive tools, plus streamlined inter-
operability with Autodesk MotionBuilder. Unified tools
between Maya and MotionBuilder let you easily retarget
motion capture animation from MotionBuilder and
apply to rigs set up in Maya.

See What's New in Rigging (page 16).

Dynamics and nDynamics

New Fluid Effects simulation methods let you create
realistic liquid pouring, splashing, and boiling effects.
Other additions to Fluids include new output mesh
options, improved auto resizing, and a number of new
attributes to enhance the look and behavior of your
effects.

Further development of the Nucleus unified simulation
framework includes multi-threaded nParticle collisions
and nCloth self-collisions for faster performance, per-
object local gravity and wind for greater control over
Nucleus forces, and rigid nCloth shells for small-scale
destruction effects.

The addition of Effects Assets provide a wide range
of easy-to-use, customizable effects, including fire,
smoke, explosion, dust trail, melt, and fireworks.

For the Autodesk Maya Entertainment Creation Suites,
Dynamics and Effects provides single-step Softimage
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ICE interoperability which lets you take advantage of
the ICE (Interactive Creative Environment) to create
effects for your Maya scenes.

See What's New in Dynamics and nDynamics (page
19).

Rendering and Render Setup

You can now easily create render pass nodes through
the Hypershade and view the output of these passes
directly in the Render View. Furthermore, you can
create basic compositing graphs using render passes,
render targets, and standard Maya shading utility
nodes, and visualize the result directly in the Render
View or via a batch render.

New Viewport 2.0 features include improved support
for most parts of Maya, for example, manipulators,
tools, shapes, and nodes. New effects such as screen-
space ambient occlusion, motion blur, depth of field
and multisample anti-aliasing are also included.

Two new performance options are provided for View-
port 2.0: Use Vertex Animation Cache and Thread
Dependency Graph Evaluation.

You can also preview Ptex textures assigned to any
standard Maya shading network texture input in
Viewport 2.0.

In addition, the new Maya Hardware 2.0 renderer
allows you to perform command line rendering for
Viewport 2.0, or to batch render to disk or to Render
View.

See What's New in Rendering and Render Setup (page
28).

Documentation

Read about changes to how we deliver Maya Help, Maya API and other learning
resources to you. In addition, you’ll find information about new learning
resources available to you.
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See What's New in Documentation (page 32).

API

Beginning Maya 2012, you can use the new extension attributes feature to
add attributes to a given node class so that they appear as static Maya attributes.

See What's New in API (page 31).

The API Guide and API reference are now a separate part of the Maya help
and includes new features such as: more links from the API Guide to API
elements such as classes and functions, and color coded syntax in example
code in the API Guide.

See http://www.autodesk.com/maya-sdkdoc-2012-enu.

What's New in General

Interoperability

You can now send new scene data or updates to currently open scenes from
Maya to Softimage, MotionBuilder or Mudbox. You can access the new
one-click options from the File menu.

New options added to cmdScrollFieldExecutor command

New options have been added to the cmdScrollFieldExecutor command,
including: a case sensitive replace all, a flag to query the total number of lines,
and a flag to enable wrapping of the search function. For more information,
see the Commands documentation and the release notes.

Improved Direct Connect support

Direct Connect support has now been updated to Direct Connect 2012 on
the Windows and Mac OS X operating systems, and Maya 2012 supports the
importing and exporting of more file formats, as well as better parity between
Windows 32-bit and Windows 64-bit systems.

What's New in Performance

The following sections describe some performance improvements in Autodesk
Maya 2012.
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General

■ Improvement with MDGContext matrix evaluation: evaluating of multiple
matrices within the same frame time is improved.

■ Two new options have been provided to improve performance with
Viewport 2.0: Vertex Animation Cache and Thread Dependency
Graph Evaluation. See Renderer > Viewport 2.0 for more information.

■ Performance optimizations reduce save times for Maya Ascii (.ma) files,
particularly for scenes containing large meshes.

Dynamics and nDynamics

■ Improvements to Fluid Effects includes enhancements to the interactive
draw and fluid output meshing. See What's New in Fluid Effects (page 21).

■ Additional Nucleus solver threading improves the performance of playing
back nCloth and nParticle simulations. See What's New in nCloth (page
26) and What's New in nParticles (page 28).

What's New in Basics

Updates to the Project Window

An improved Project Window makes it easier to organize and customize
Maya project files. These updates include:

Primary and secondary project locations

When you create a new project from the Project
Window, Maya now organizes project files into
primary and secondary project locations. Primary
project locations provide directories for essential project
data such as scene files, texture files, and rendered
image files. Secondary project locations are sub-direct-
ories created in the primary locations to provide addi-
tional project management.

You can specify different locations for each primary
project directory and secondary project sub-directories,
as well as provide custom directory names. A new
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browse feature lets you quickly navigate to the desired
location for each project directory.

Translator and custom data locations

The Project Window also provides customizable direct-
ories for translator data. You can use the default loca-
tions or specify custom locations that better correspond
to your production pipeline.

You can also add new custom directories to your Maya
project using the Add new file rule command.

Help preferences

New Help Location options have been added to the Maya Preferences to
accommodate the new way that Maya Help is published.

Selection preferences

There are three new modifiers available in the Selection section of the
Preferences window:
■ Auto-select asset

■ Track selection order

■ Selection type effects active
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What's New in Assets and File Referencing

Namespace Editor improvements

Improvements to the Namespace Editor give you
more control creating and managing the namespace
organization of your scene objects. The editor features
a new tree-view display making it easier to view
namespace hierarchy.

Other improvements include:
■ List Contents now displays the list of objects in a pop-up

window rather than just in the Script Editor window.

■ Select All Empty makes it easy to select and operate on all
empty namespaces.

■ Collapse to Child removes empty ancestor namespaces.

■ Set Current provides a visual indicator and control for the
current namespace.

Retry missing reference files

A Retry option has been added to the Reference file not found window.
You can now locate missing reference files, restore them to original referenced
location, and then click Retry to load them into the scene.
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What's New in Modeling

Send Objects to Mudbox

You can now send objects from Maya to Mudbox using
the Send To options from the File menu. Once you
have modified an object in Mudbox, you can then send
it back to Maya.

The one-click functionality allows you to send various
forms of data, including meshes and UVs on meshes,
to Mudbox. This data can be sent as a new scene or as
an update to an existing scene.

The Send to options for Maya is a feature of the
Autodesk Entertainment Creation Suites.

Edit Mesh updates

There are several new Edit Mesh menu updates, including:
■ The Project Curve on Mesh option, which allows you to project curves

onto a polygon surface.

■ The Split Mesh with Projected Curve option, which allows you to
split and detach edges on a polygon surface.

■ The Interactive Split Tool, which allows you to split faces on a polygon
mesh.

■ The new Curve options in the Extrude Face Options window, which
allow you to generate and position a curve automatically.
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Show Manipulator Tool updates

There are new sliders associated with the Show Manipulator Tool, which
allow you to modify thickness, offset and division values.

Marking menu updates and additions

The following table lists updates and additions to the Maya marking menus.

Update/additionMarking menu

Poly Edge ■ Flip/Spin Edge sub-menu added.

■ Detach Components added.

■ Connect Components added.

Poly Face ■ Assign Invisible Faces added.

■ Connect Components added.

Move, Rotate, and Select Tool ■ Soft Select toggle removed

■ Object mode toggle added

Scale ■ Menu items reordered

■ Axis sub-menu added, which includes options
for scaling axis.

■ Normal Average, Object, World scaling added

■ Soft Select toggle removed

■ Object mode toggle added

Poly Vert ■ Connect Components added.

UV Editor Comp Convert ■ To Border removed

■ To UV Edge Loop added.
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What's New in Animation

Editable motion trails

New editable motion trails let you preview your anim-
ation and interactively adjust keyframes within the 3D
scene. Motion trails provide a visual representation of
keys right around your animated models, letting you
adjust the timing, keys, tangents, and position of an-
imation directly.

Graph Editor improvements

Several new options and preferences have been added
to the Graph Editor to enhance curve editing work-
flows. In particular, animators who work with multiple
Autodesk applications can expect increased consistency
across curve editing tools. Graph Editor improve-
ments include:

Adjacent key snapping

A new preference lets you set neighboring keys to
automatically align as you edit. Depending on your
keyframe editing style, keep Snap Values to Adja-
cent Keys enabled to make similar, adjacent keys snap
to identical values.

Auto tangent type

As you move keyframes in the graph view, Auto tan-
gents can automatically self-adjust to ensure smooth
transitions, without overshooting maximum and
minimum values. Auto tangents can save animators
valuable time when roughing out animation, as tan-
gents are naturally adjusted to avoid creating spikes.
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This tangent type is common to several other Autodesk
applications, and is the new default tangent type for
new keys (set as the Default in tangent and Default
out tangent in your Animation preferences).

Isolate selected curves

Quickly narrow your focus in the graph view by
showing only the curves you want to work with. The
new Curves > Isolate Curve option lets you easily
view curves for selected channels only.

Scale multiple keys

The new Region tool provides a simple, more visual
mechanism for scaling multiple keys in time and value.
Select the Region Tool from the Graph Editor
toolbar, select the region of curves you want, then drag
the region handles to scale.

Simplified toolbar option

The View menu now includes a Classic Toolbar
option which toggles the Graph Editor between the
classic, full toolbar, and a more simplified toolbar that
displays a smaller set of options. Switching off Classic
Toolbar gives animators who primarily use Maya as
part of a suite a more streamlined display of curve
editing tools.

In addition, several Graph Editor icons have been
refreshed for this release.

Single-click curve editing

A new Left Mouse Button Alters Selections pref-
erence, on by default, lets you adjust selected keyframes
with a single click. With this preference enabled, you
can simply click and drag to move a selected keyframe
in the graph view area. This keyframe manipulation
mode will be familiar to animators who already use
curve editing tools in other Autodesk products such as
MotionBuilder.
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Tangent type feedback

The Graph Editor now provides visual feedback on
the tangent type of selected keys. If all selected keys
have the same tangent type, the appropriate tangent
icon is highlighted in the Graph Editor toolbar. If
the selected keys have different tangent types, no
feedback displays.

Camera Sequencer updates

Ubercam

Create an ubercam to playback all camera shots in a
sequence using a single camera.

When you create an ubercam, the Camera Sequencer
bakes camera parameters from each shot to this single
camera, letting you conserve camera switches. If you
modify the source cameras in your shots, simply recre-
ate the ubercam to update.

Shot Playlist window

The new Shot Playlist window lets you quickly edit
camera shot parameters, such as shot length or the
camera used.

Additional Playblast options

■ Resolution Width and Resolution Height ad-
ded to Playblast Sequence options

■ Offscreen render option for playblasting (Playblast Shot,
Playblast Sequence, and Re-playblast Shot Options)

Multi-track audio

(Windows and Linux only) You can now add
multiple audio tracks to a sequence.
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Interoperability with Autodesk Smoke

Several enhancements to the Camera Sequencer let
you produce XML files that can be imported in
Autodesk Smoke.

Synchronized Channel Box, Graph Editor, and Time Slider

Two new items in the Channels menu of the Channel Box let you set
whether to synchronize your selections in the Channel Box to the Graph
Editor and Time Slider. When Sync Timeline Display is on, selecting
channels in the Channel Box also filters the Time Slider to display only
keys for those channels, and only those selected channels are keyed if you set
a keyframe. When Sync Graph Editor Display is on, only curves for those
selected channels display in the Graph Editor.

Craft Animations plug-in

Maya now includes pre-rigged models of two cars and two planes from Craft
Animations, as well as the Craft SoftMotionCam, ObserverCam, MultiStateCam,
and HumanizerCam camera rigs.

You can use the vehicle rigs to quickly set up your existing vehicle models for
animation, control the vehicles using custom input devices, and record
keyframe animation of the vehicle actions and your camera rigs.

For complete documentation on the Craft Animation rigs and cameras, use
the Help menu in the Craft Animation Director Studio plug-in window. For
more information on Craft Animation, see http://www.craftanimations.com.

Motion capture samples

The Visor window now includes additional motion
capture example files that you can use with the charac-
ter animation retargeting tools.

To find the mocap examples, open the Visor (Win-
dow > General Editors > Visor) and switch to the
Mocap Examples tab. The additional files are organ-
ized under male and female character groupings in the
navigation panel.

What's New | 15
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What's New in Rigging

New HumanIK character setup tools

Two new character setup tools improve your HumanIK character workflow.
These tools are designed to build on the existing HIK retargeting workflows,
and add new features for keyframers, such as keying groups and rig
synchronization.

Select Window > Animation Editors > HumanIK or Skeleton >
HumanIK to access these new tools, along with the existing Skeleton
Generator tool.

Characterization Tool

The new Characterization Tool provides character
animators with an improved, more visual tool for
mapping and defining the structure of HumanIK
characters.

Designed to allow a streamlined, consistent workflow
with other Autodesk applications, the Characteriza-
tion Tool helps to enhance your HumanIK character
animation pipeline, with improved error reporting and
an intuitive, visual interface.
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Character Controls window

The new Character Controls window gives you a visual
interface for interacting with the FK and IK effectors
on your Control rigs.

The Character Controls let you activate different
manipulation and keying modes depending on
whether you want to work on the entire body, specific
body parts, or only the current selection. The Figure
representation gives you constant visual feedback on
which parts of the character are active for keying, reach
and pull values.

Other controls let you quickly pin and unpin Control
rig effectors, create auxiliary and pivot effectors, and
adjust the reach and pull properties between a Control
rig and its retargeting source.

NOTE

With the addition of superior full body rigging and animation capabilities
with HumanIK in this release of Maya, the former full body IK (FBIK) solution
has been removed. You can still load your existing scenes with FBIK rigs,
however all FBIK menus and options have been removed from Maya by default.

For archived information on FBIK, including instructions for restoring the
FBIK menus and options in Maya, you can find a Full Body IK reference guide
on the Maya documentation Archives page at
http://www.autodesk.com/maya-docs-archive.

Other HumanIK keying workflow improvements

■ Keying groups in Time Slider, Graph Editor, and Dope Sheet

■ Improvements to animation layers and retargeting workflow

■ Autokey support for HIK keying groups

MotionBuilder interoperability

You can now use Send to commands to transfer HumanIK character data
between Maya and MotionBuilder. This means you no longer need to export
your characters from Maya to FBX to import them into MotionBuilder. To see
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the Send to MotionBuilder commands in the Maya File menu, you must
have MotionBuilder installed on your computer.

MotionBuilder interoperability is a feature of the Autodesk Entertainment
Creation Suites.

Improved joint orientation behavior when moving joints

When you move joints, the joint rotation axis of the parent is now
automatically adjusted so that it continues to point down the bone. A new
Automatically Orient Joints setting in the Move Skinned Joints Tool
and the Move Tool lets you turn this behavior on or off.

Deformer enhancements

Export and import deformer weights

You can now export and import deformer weight maps in XML format. New
items added to the Edit Deformers menu let you export and import skin
weight data, providing an easy way to transfer weights from one character
mesh to another.
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What's New in Dynamics and nDynamics

General

Effects Assets

Maya now includes a number of preset effects called
Effects Assets. Building on the Maya Asset framework
and simulation toolsets, Effects Assets present the most
relevant attributes for an effect, making them easy to
customize for your scenes. Effects Assets are available
in the Visor window.
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ICE Interoperability for Maya

Maya now includes a one-click interoperability work-
flow that lets you transfer data between Maya and
Softimage. Using Send to commands, you can export
a scene to Softimage, add a Softimage ICE particle or
deformation effect, then send the scene back to Maya.

ICE interoperability for Maya lets you take advantage
of the ICE (Interactive Creative Environment) to create
effects for your Maya scenes.

ICE interoperability for Maya is a feature of the
Autodesk Entertainment Creation Suites.

New Nucleus node attributes

Maya 2012 includes the following new Nucleus node attributes:

Transform Attributes

The Nucleus node now includes Transform Attributes and other Maya
transform node properties. You can now create parent-child relationships with
other objects in your scene. When you parent the transform node to another
object, the simulation takes place in the local space of the Nucleus node, rather
than in worldspace. A Use Transform attribute enables the transform
properties.

When Use Transform is on, you can set the Transform Attributes
attributes to specify the scene location of the Nucleus gravity and wind. The
bounding box at the location defined by the Translate X, Y, and Z values
determine the area affected by the Nucleus forces.

Visibility

When on, arrows appear in the scene to display the location and direction of
Nucleus Gravity and Wind. Visibility also displays the location of the
Nucleus plane when the Use Plane attribute is on.
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PhysX for Maya plug-in

Maya now includes the NVIDIA® PhysX® for Maya plug-in which lets you
take advantage of using GPU-accelerated physics simulations in your Maya
scenes. The plug-in lets you create dynamic, kinematic, and static rigid bodies
from meshes created in Maya. You can then join the rigid body objects with
PhysX constraints.

The PhysX plug-in also includes kinematic ragdoll simulations and APEX
Clothing.

PhysX for Maya is available for Windows systems only. For more information
on PhysX, see http://www.nvidia.com.

For documentation on the PhysX for Maya plug-in, browse to the
Documentation folder located in the PhysX installation directory.

Digital Molecular Matter plug-in for Maya

The DMM™ (Digital Molecular Matter) plug-in for Maya from Pixelux
Entertainment™ is now included with Maya 2012. The plug-in helps you
create highly realistic shatter, destruction, and deformation simulations that
can include multiple interacting materials. The DMM plug-in available with
Maya will solve up to 1500 tetrahedrals.

The DMM plug-in is available for Windows, Mac OS X, and Linux systems.
For more information about using the DMM plug-in see http://www.pixelux.com.

Fluid Effects

Liquids attributes

A number of new Liquids attributes let you generate fluid effects that look
and behave like real liquids.
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These new attributes include:

Liquid Method

New liquid simulation methods let you select a solver
that best suits your effect. When Enable Liquid
Simulation is on, you can select either Liquid and
Air or Density Based Mass as your Liquid Method.

Liquid Min Density

Specifies the density value at which the solver differen-
tiates between liquid and air when the Liquid and
Air simulation method is used. Liquid densities are
calculated as incompressible fluids while air is fully
compressible.

Liquid Mist Fall

Applies a downward force to areas in the fluid that
have density lower than the value specified by the Li-
quid Min Density attribute. When Liquid Mist
Fall is set to 0, no force is applied. Increasing the at-
tribute value increases the strength of the downward
force.
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Mass Range

Defines the relationship between mass and fluid
density when the Density Based Mass simulation
method is used. At high Mass Range values, dense
regions in the fluid are much heavier than the empty
regions, simulating a relationship similar to water and
air.

Tension Force

Applies a force that simulates surface tension based on
the density in the grid. Tension Force is similar to
Density Tension, but rather than modifying density
values, Tension Force modifies momentum by adding
small amounts of velocity to the fluid.

You can use Tension Force with Density Tension
to create realistic surface tension in your liquid effect.

Density Tension

Smooths ranges of density into round shapes, making
the density boundaries more defined in the fluid. You
can use Density Tension to create effects that are
similar to surface tension in liquids.
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Density Pressure and Density Pressure Threshold

Applies an outward force to counter the compression
that Forward Advection can apply to fluid density,
particularly along container boundaries. In this way,
the attribute attempts to conserve the overall fluid
volume with no density loss. For example, in a water
tank simulation, fluid may appear to collapse or drain
without sufficient Density Pressure.

Density Pressure Threshold specifies the density
value at which Density Pressure is applied on a per
voxel-basis. For voxels that have density lower than
Density Pressure Threshold, no Density Pressure
is applied.

Density Pressure and Density Pressure
Threshold can also be used with the default fluid
solver method when Enable Liquid Simulation is
off.

Fluid Output Mesh performance improvements and additions

Maya 2012 includes meshing performance improvements and new output
mesh attributes.

Mesh Method

Using Mesh Method, you can now choose the type
of polygon mesh used to generate your fluid output
mesh.

Mesh Smoothing Iterations

You can apply smoothing iterations to your output
mesh to increase quality and uniformity of its surface.

Fluids output mesh performance improvements

Maya 2012 includes performance improvements when
converting a fluid object to a polygon mesh. These
improvements are most noticeable when using Tri-
angle Mesh or Quad Mesh as the Mesh Method.
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Air/Fuel Ratio

Sets the amount of air required to completely burn a
set volume of fuel. For example, to burn a volume of
gasoline requires 15 times more air than fuel. To simu-
late a gasoline fire, set Air/Fuel Ratio to 15.

You can access Air/Fuel Ratio from the Fuel section
of the Contents Details attributes.

Pressure and Pressure Threshold

A new Pressure attribute has been added to the Temperature grid to
simulate the effect of temperature on gases. The Pressure attribute simulates
the increase in pressure that results when a gas gets hotter and quickly expands.

Pressure Threshold specifies the temperature value at which Pressure is
applied on a per voxel-basis. For voxels that have temperature lower than
Pressure Threshold, no Pressure in applied.

You can access Pressure and Pressure Threshold from the Temperature
section of the Contents Details attributes.

Auto Resize Margin

Auto Resize Margin specifies the number of empty voxels added between
the fluid container boundary and regions of positive density in the fluid. Auto
Resize Margin lets fluids flow more naturally near auto-resized boundaries
and is useful for fast-moving and low density fluids.

Auto Resize In Substeps

A new Resize In Substeps attribute lets you resize a fluid container each
substep. In previous versions of Maya or when Resize in Substeps is off,
fluids only resize one voxel per simulation step. With Emit In Substeps on,
fast moving fluids resize more accurately especially when a higher number of
substeps are used.
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Emit In Substeps

A new Emit In Substeps allows fluid emission to be computed each substep
rather than once per step. Emit In Substeps is useful for effects that have
fast emission speeds such as explosions.

Fluid playback improvements

With improvements to the fluid interactive draw, fluid effects now play back
faster. Better performance is most noticeable when playing back textured fluids
or cached fluid effects. The interactive draw improvements also provide faster
real-time manipulation (tumble, dolly, rotate) of fluid containers, particularly
when using internal lighting (Real Lights turned off) for the effect.

nCloth

Rigid nCloth shells

You can now apply Rigidity and Deform Resist-
ance to the individual polygon shells that make up
your nCloth mesh. When meshes made from individu-
al polygon shells are converted to nCloth, a new Use
Polygon Shell attribute enables Rigidity and De-
form Resistance on each shell. The shells then be-
have as individual rigid objects in simulations.

Use Polygon Shells is useful for creating simple de-
struction and other rigid self-colliding effects.

Local Force and Local Wind

New Local Force and Local Wind attributes let you apply gravity and wind
to individual nCloth objects. These forces are applied locally and do not affect
other Nucleus objects that are assigned to the same solver.

You can use Local Force to reduce or increase the effects of gravity on specific
nCloth objects, making the garments appear lighter or heavier than other
articles of a character's clothing. By adding Local Wind, you can create gusts
of wind that act on specific areas of a character's clothing such as a flowing
cape.
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Collide Last Threshold

A new Collide Last Threshold sets whether or not a collision iteration is
the last calculation performed each simulated step. Collision Last Threshold
helps ensure that nCloth collisions with Nucleus objects are resolved at the
end of a step, decreasing the chance of bad collisions in the subsequent frames.

Input Motion Drag

Using Input Motion Drag, you can now apply a force to an nCloth which
is based on the motion of an animated input mesh. This force is derived from
the difference between the current velocity of the nCloth object and the
velocity of its animated input mesh. An Input Motion Drag value of 1
means that the force will cause the nCloth object to follow the same path as
its input mesh. An Input Motion Drag value of 0 has no effect on the
nCloth object. You do not need to have Input Mesh Attract set to use
Input Motion Drag.

nCloth performance improvements

Additional Nucleus solver threading improves the performance of nCloth
simulations. Better performance is most noticeable when playing back
simulations with multiple nCloth objects connected to the same Nucleus
solver. In this case, computations for self-colliding surfaces and stretch
resistance are threaded.

Paintable attributes

A number of attributes have been added to the list of paintable nCloth
properties. You can now can use the Paint nCloth Attributes Tool to
create vertex maps and texture maps for the following attributes:
■ Bend Angle Dropoff

■ Restitution Angle

■ Damp

■ Lift

■ Drag

■ Tangential Drag
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nParticles

nParticle performance improvements

Additional Nucleus solver threading improves the performance of nParticle
collision detection, making large nParticle simulations faster particularly when
Enable Liquid Simulation is on, and when nParticles are colliding with
other Nucleus objects.

Local Force and Local Wind

New Local Force and Local Wind attributes let you apply gravity and wind
to individual nParticle objects. These forces are applied locally and do not
affect other Nucleus objects that are assigned to the same solver.

Particle color emission enhancements

You can now use the Texture Emission Attributes, such as Inherit Color
or Inherit Opacity to color particles emitted from all emitter types. In
previous versions of Maya, these attributes can only be used with Surface
emitters. To use Inherit Color or Inherit Opacity, you must disconnect
the corresponding internal shading ramp from the nParticleShape node. To
do this, in the Per-particle (Array) Attributes, right-click on the
per-particle attribute, and select Break Connection.

These enhancements are also supported by Maya classic particles.

What's New in Rendering and Render Setup

New Viewport 2.0 features

New Viewport 2.0 features include improved support
for most parts of Maya, for example, manipulators,
tools, shapes, and nodes.

Two new performance options are provided: The Ver-
tex Animation Cache option provides more inter-
active scrubbing of your animation, and the Thread
Dependency Graph Evaluation option provides
better performance by evaluating separate characters
in separate threads.

28 | Chapter 1   What's New



New API support for plug-in shapes, hardware shaders,
and locators is provided. Approximated support in the
viewport is provided for mia_material_* shaders and
other mental ray shaders. New effects include screen-
space ambient occlusion, motion blur, depth of field
and multisample anti-aliasing.

In addition, the new Maya Hardware 2.0 renderer
allows you to perform command line rendering for
Viewport 2.0, or to batch render to disk or to Render
View. You can access the Hardware 2.0 renderer
from the Render View window, the Render Set-
tings window, the Script Editor, via the command
line renderer, or by selecting Render > Batch
Render.

Previewing your composite in the Render View

You can now easily create render pass nodes through
the Hypershade and view the output of these passes
directly in the Render View. Furthermore, you can
create basic compositing graphs using render passes
and standard Maya shading utility nodes, and visualize
the result directly in the Render View or a batch
render using the new render target node.

Vector displacement maps

Connect a vector displacement map to your shading
group in Maya to create complex sculpted surfaces with
displacement in arbitrary directions; for example, to
create undercuts or overhanging features. You can
create vector displacement maps in Mudbox or any
comparable software.

You can use this feature with any Maya or mental ray
shader; however, you cannot visualize vector displace-
ment maps in the scene view, and you must render
using mental ray for Maya.

What's New | 29



Support for Ptex textures

Maya 2012 provides you with the ability to preview
Ptex textures assigned to any standard Maya shading
network texture input in Viewport 2.0.

new mental ray Rendering book

All mental ray shading and rendering documentation has now been moved
to the new mental ray Rendering book. mental ray specific nodes and attributes
descriptions have been moved to the mental ray node attributes chapter.

mental ray attributes only accessible when mental ray plug-in is loaded

Previously, all mental ray attributes were available in the nodes' Attribute
Editor regardless of whether the mental ray plug-in was loaded.

Beginning with Maya 2012, mental ray attributes are only accessible when
the mental ray plug-in (Mayatomr.mll) is loaded.

mental ray for Maya users should ensure that the Mayatomr.mll plug-in is set
to Auto load in the Plug-in Manager.

mental ray support for compressed .tif files

mental ray for Maya now supports input of LZW compressed .tif texture files.

EXR version 1.7 support

The EXR version 1.7 support of channel names of length 252 characters is
available in Maya 2012. To utilize this option, create and set the
MAYA_EXR_LONGNAME environment variable to 1. You must ensure,
however, that any other applications you are using also support this standard.
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What's New in API

Extension attributes

Beginning Maya 2012, you can use the new extension attributes feature to
add attributes to a given node class so that they appear as static Maya attributes.

You can add or remove extension attributes via the API MDGModifier class.
Alternatively, you can do so using the MEL/Python addExtension and
deleteExtension commands.

New API Help features

The API Guide and API reference are now a separate part of the Maya help
and can be found at http://www.autodesk.com/maya-sdkdoc-2012-enu. In addition,
the API Help includes the following new features:
■ More links from the API Guide to API elements, for example, classes and

functions.

■ Color coded syntax in example code in the API Guide.

■ API Reference included in table of contents.

■ Faster search.

New QT features

■ Qt now uses version 4.7.1.

■ Support for custom Qt widgets for use with Qt Designer.

■ For Windows and Linux users, Qt Designer is installed with Maya. For Mac
OS X users, you can find Qt Designer directly at the Qt Development Tools
website; or, you can build Qt from source. To find a version of the Qt
source code that has been modified by Autodesk to include changes needed
by the Maya UI, see Customize the interface.

What's New in MEL and Python

Please see the HTML version of this document for a list of added, deleted, and
changed MEL/Python commands
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What's New in Documentation

Maya Help on Autodesk.com

Starting this release the Maya Help is being published to the Autodesk.com
website. By default, Maya 2012 calls the help from a web location to provide
you with the latest documentation available. This shift to publishing directly
to the web means we can provide regular updates and additions to content
in an ongoing manner. This change also significantly reduces the footprint
of locally installed data to your machine and makes the install and uninstall
of Maya quicker.

A download version of the 2012 Maya Help will be available for those who
prefer a local copy.

Maya Learning Channel on YouTube

A dedicated Autodesk Maya Learning Channel is now available on YouTube,
providing trusted content authored by Autodesk. The channel streams videos
on various workflows, features, and interoperability topics. New videos are
posted regularly; subscribe to the channel to receive notification.
■ www.youtube.com/mayahowtos

Online documentation archive

Several chapters of the Maya Help that have not been recently updated are
now available in an online archive. To access the archive, see
http://www.autodesk.com/maya-docs-archive.

API Guide and mental ray Manual new locations

The API Guide, Maya API reference, and mental ray Manual are now separate
from the Maya help.
■ API Guide and API reference: http://www.autodesk.com/maya-sdkdoc-2012-enu

■ mental ray Manual: http://www.autodesk.com/mentalray-help-2012-enu

FBX documentation

As of this release, all FBX Help documentation is available from a website,
rather than installed locally.

Click the Help on FBX button in the plug-in to access documentation online.
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The Autodesk FBX Help option has been removed from the Autodesk Maya
Help menu. You can now find FBX information included as a part of the Maya
Help.

What's New - Previous versions

What's New - Previous versions

To view the What’s New from previous versions of Autodesk Maya, see
http://www.autodesk.com/maya-whatsnewdocs.
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